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Purpose 

The purpose of this document is to guide persons responsible for content and document 

generation in creating accessible PDFs.  

Terms and Definitions 
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Term Definition 

Accessible PDF  

A PDF document that makes use of accessibility features built into the 

document. These features allow users with disabilities to navigate and use 

the document by means of assistive technology. 

Alternative Text 
Descriptive text for graphics (see Figure): invisible to the sighted user and 

discoverable by screen readers.   

Assistive 

Technologies 

A family of hardware and software tools that assist people with disabilities to 

navigate, read, and understand applications and documents. For example, 

screen readers are software applications that read text as speech for people 

who are blind or have low vision. 

Figure 
A tag name, used to describe all kinds of graphics, including charts, graphs, 

photographs, logos, designs, and illustrations.  

Form 

Any document with one or more fields in which the user can enter 

information. Forms in PDFs are usually not submitted directly to a database, 

but the PDF may allow the user to save and print out the completed form. 

Heading 

Any form of title within a document: often visually distinguished by color, 

being off-set from other text, a larger font size or bold font weight. Headings 

and sub-headings divide and organize content. 

List A form of content organization, prefaced by points ("bullets") or numbers. 

Paragraph Any discrete body of text with one or more sentences.  
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Term Definition

Table 
A form of content organization in rows and columns, in which header cells 

describe their subsequent data cells. 

Tag 
A unit of accessibility markup that semantically describes content for screen 

readers. 

Introduction 

The goal of this document is to guide persons responsible for content creation—for example, 

City and Municipal staff, Communications/ Marketing specialists—in creating accessible PDFs 

for their customers as well as the general public. Many people from the public and private 

sectors approach T-Base Communications with a requirement or desire to provide accessible 

documents, but they lack the knowledge or capacity to do so themselves. There is confusion 

regarding what an accessible PDF is and what makes it "accessible". In this guide, T-Base 

intends to clear up these misconceptions and help people create PDFs that are consistent and 

accessible. 

Understanding Accessible PDF 

Accessible HTML Webpage vs Accessible PDF 
First, we must distinguish between an accessible HTML webpage and an accessible PDF. Both 

are essentially documents, and they share an important quality. Each can be considered 

accessible if it is compatible with assistive technologies and can be comprehensibly read and 

navigated by people with disabilities. Assistive technologies come in different forms and help 

people with disabilities understand and navigate within applications and documents. A screen 

reader, for example, is an example of an assistive technology that reads text as speech for 

people with visual disabilities.  

Accessible HTML Webpage 

A webpage is primarily coded in HTML. Each object is described using "tags", which are the 

basic unit of HTML. Tags are used to define document objects: regions of content, lines of 

text, and individual words; tables; images; multi-media; navigation; and others. A major part 
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of creating an accessible webpage is deciding how to choose the correct tags in order to assign 

meaning, structure and location within a document. 

Accessible PDF 
PDFs are fundamentally different from HTML webpages. Though there is an underlying object 

structure similar to HTML tagging, for the most part content creators do not have to worry 

about tags in PDFs. Because most creators are working in an application, such as Microsoft 

Word or Adobe InDesign, they do not work directly in this underlying structure. When we talk 

about "tags" in PDF, we are specifically talking about tags that are added after the document 

has been created so that a screen reader can read its elements. In fact, tags are added to a 

PDF solely so that people using screen readers can understand the document. Without these 

tags, the document visually appears the same to sighted users, but its content won’t be 

available to people using screen readers.  

The bottom line: Choosing the correct tags while building an HTML webpage and adding 

meaningful tags to a PDF are crucial in creating accessible documents. They just mean 

different things. 

WCAG 2.0 vs PDF/UA 

Many of our public and private sector clients ask if it is it is possible to make their PDFs 

"compliant with WCAG 2.0". Because there is not a straightforward answer, it is important to 

understand what kind of compliance to work toward. 

The Web Content Accessibility Guidelines (WCAG) 2.0 is a set of recommendations for 
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improving and measuring the accessibility of online content. They were created by an 

international organization called the World Wide Web Consortium (W3C), which creates 

technical standards for internet technologies. WCAG 2.0 is a recognized standard for online 

accessibility worldwide. It is important to note that PDFs are mentioned in WCAG 2.0 in the 

context of "web content"; however, there is also a separate document of PDF Techniques for 

WCAG 2.0, highlighting that there is a difference between PDF and other web content. PDFs 

were originally created to be delivered in a self-contained document format (not for web 

presentation). In the words of the Association for Information and Image Management (AIIM), 

a global community of information professionals, PDFs are sometimes described as "not 

essentially of the Web". WCAG 2.0 includes PDFs as web content, but overall these guidelines 

focus on HTML-based webpages. 

http://www.w3.org/TR/WCAG20/
http://www.w3.org/TR/2014/NOTE-WCAG20-TECHS-20140408/pdf.html
http://www.w3.org/TR/2014/NOTE-WCAG20-TECHS-20140408/pdf.html
http://www.aiim.org/Research-and-Publications/standards/committees/PDFUA/WCAG20-Mapping
http://www.aiim.org/Research-and-Publications/standards/committees/PDFUA/WCAG20-Mapping
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Recently there has been emphasis on a separate recommendation called PDF/UA, an ISO 

standard (ISO 14289-1) that defines the requirements for PDF accessibility exclusively and 

has led to the creation of subsidiary documents. 

The PDF Association used PDF/UA to create the Matterhorn Protocol (along with other 
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educational resources) to produce testable criteria. The Protocol is a set of 31 checkpoints and 

136 failure-based sub-checkpoints to test the accessibility of PDF documents. Most criteria can 

be tested automatically using software, primarily the PAC 2 Accessibility Checker, while others 

require human/user testing. 

The more specific goal of this guide is to drive the conversion of documents into PDFs that 

pass the PAC 2 Checker and are compliant with PDF/UA. Within PDF/UA there is latitude when 

it comes to interpreting how to accomplish this goal and how to interpret the results of the 

PAC 2 Checker. This is important considering the wide variety of PDF documents created. Keep 

in mind that a PDF may be compliant with a standard yet not capture the meaning its creators 

intended. Therefore, do not assume that each PDF can be rendered accessible in the same 

manner. 

There are two final recommendations regarding creating an accessible PDF. First, always 

examine a PDF before attempting to modify it for accessibility. Before starting the process, 

look at the task and determine what logical steps are needed to make the document 

accessible. Finally, before declaring the document accessible, perform a test read with a 

screen reader. Doing so will demonstrate how the document performs with an assistive 

technology, which is more useful than simply relying on an automated checking tool.  

Assumptions and Requirements 

Since PDFs can be created from a wide variety of sources, this guide makes certain 

assumptions and requirements when it comes to creating and editing documents. For the 

purpose of this guide, we assume the original document is created in Microsoft Word (MS 

Word). MS Word is the most common software for generating content, and of all Microsoft 

Office applications, it has the largest number of accessibility options.  

When the MS Word document is complete, you must use conversion software to render it as a 

PDF. Simply saving an MS Word document as a PDF will not make it accessible. What is 

needed is an application that will recognize the accessibility features you have added to the 

document. Adobe FrameMaker®, Adobe InDesign®, Adobe PDFMaker®, CommonLook Office, 

and OpenOffice Writer are common applications used to create tagged PDF documents.  

http://www.pdfa.org/2014/06/matterhorn-protocol-1-02-now-available/
http://www.access-for-all.ch/en/pdf-lab/pdf-accessibility-checker-pac.html
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Adobe Acrobat is required in order to review and manipulate the tags in an existing PDF 

document, and it has a useful Accessibility Checker. The next section in this guide looks at a 

more powerful testing tool, the PAC 2 Checker. 

Document Creation in MS Word 

MS Word contains several features that can enhance the accessibility of a final document. 

Using them while working on the source document will probably save time and create better 

structure and accessibility for the final PDF. It means adding accessibility from the beginning 

of the project, and less remediation at the end. 

Styles 
When creating or editing a block of text, many people will directly manipulate the visual 

properties to make text look how they wish—when creating headings and subheadings, lists, 

or block quotes, among other components. Unfortunately these visual changes do not help 

create structure within the document, are not necessarily accessible to ATs, and will need to 

be repeated or edited manually every time they occur. Instead of manipulating the visual 

elements directly, content authors should use the document styles and style sheets.  

In MS Word, styles are declared categories of content, which store determined properties for 

specific kinds of text content, such as font weight, font size, and decoration. The author, or his 

or her organization, determines the style properties and can then assign a style one or more 

times to a given block of text content. 

Styles permit easier content administration. The content author has to change the properties 

of a style only once, as the change will propagate to every piece of content using each 

particular style. More importantly, styles help create structure in the document, identifying the 

organization and major areas of content by establishing headings. This makes it easier for ATs 

to interpret, present, and navigate the document. 

ATs use the document structure to quickly analyze the document, identifying the headings, 

links, tables, and lists within each page. With ATs, the user can review and understand the 

major areas in the document as well as jump to their section of choice rather than scroll 

laboriously through all preceding content.  

Figure 1 shows two areas in MS Word where styles can be found and used: in the ribbon at 

the top of the document and in the expandable panel on the left side of the screen. Styles can 

be selected, modified, created, or organized into stylesheets using the controls in these areas. 
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If you work for a large organization, the organization likely has pre-defined stylesheets you 

can use. Ensure you become familiar with and utilize your organization’s styles. 

Figure 1: Styles are available in the ribbon and from the expandable panel. 

Headings 
Establishing headings is probably the most important use of styles. In this sense, headings 

refer to the following: 

· document title (could use Heading 1, or  a style called Title); 

· major headings (Heading 1s or 2s, usually); and all 

· sub-headings (Heading 3s, 4s, etc.). 

As mentioned, many content authors will represent the above by changing individual visual 

properties. Document title, headings and sub-headings are crucial to creating an organized 

document structure, as ATs both identify these styles and use them to facilitate document 
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navigation.  
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There are a few rules for applying headings properly: 

1. The document should have one Title to identify it. 

2. The Title is very similar to or the same as the document name. 

3. Throughout the rest of the document, generally Headings 1 through 6 are used. 

4. Chapters/major sections are identified by Heading 1s. 

5. Sub-sections within main sections are divided into Heading 2s, then Heading 3s, etc. 

6. Levels should not be skipped and should properly "nest" within each other: 

· Heading 1 

· Heading 2 

· Heading 3 

Tables 
Tables, also called “data tables”, are a widely misused element. Tables are for storing 

information with common traits or descriptions: contact lists, events, weather information, etc. 

They are also called "data tables" and should be used for that purpose. The intent of tables is 

the presentation of information, not the layout of content. Tables should not be used for 

layout; this isn't their semantic purpose, and such use might cause confusion for users who 

rely on ATs. 

Tables have special navigation options in ATs. Header cells can be identified by ATs and 

provide both a basis for navigation and an index for the values in the ordinary data cells. 

Header cells can be in the first row or column, or both. Simple tables can have one of either a 

header row or a header column, though complex tables may have several tiers. To assist ATs 

in explaining tables, include a caption either above or below the table. These attributes—

properly-made tables, captions, and values indexed to header cells—carry over to PDF when 

the document is converted, and they are screen reader-accessible. 

In Figure 2 below, the MS Word ribbon controls for tables are shown. The Design tab for the 

Table Tools contains two checkboxes: "Header Row" and "First Column". These specify if the 

respective table areas will be marked as header cells—categories of information that the data 

cells within are organized by. These attributes can carry over to the PDF upon conversion. 
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Figure 2: Controls in the ribbon for the table design, including defining the header 

cells. 

Lists 
The topic of lists includes both ordered ("numbered") and unordered ("bullet point") lists. 

Often ATs can identify lists in documents and help the user navigate them, so it is important 

not to substitute hyphens, bullet characters, or manually type in numbers. Always use the MS 

Word controls to create ordered and unordered lists. 

Figure 3: List controls in the ribbon control the list type and structure. 

Figure 3 shows the list controls in the ribbon: here a bullet list, or un-ordered list, is being 

used. Lists can also be "nested": this means child lists may be placed within parent lists. 

These are controlled with the indent buttons, which determine where child lists start and end 

under a parent. You can also assign styles to lists in the same manner as headings.  

Hyperlinks 
Hyperlinks are classically distinguished as blue, underlined text, and they are quite accessible 

to begin with. Users with color blindness or low vision may not be able to see the blue, but, 

because hyperlinks are underlined as well, they are set apart from surrounding text. As a 

general rule, hyperlinks should be distinguished from regular text by more than one visual 
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property. 
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Natural language or a proper name, not the URL, should be used as anchor text. For example, 

“Access the Accessibility Advisory Committee's agendas and minutes” uses human-
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comprehensible text as an anchor, making it much easier for users who depend on text-to-

speech to access than “Access the Accessibility Advisory Committee's agendas and minutes at 

http://www.example.com/.” Moreover, it is much more explicit than links that use "click here". 

Color and contrast in text 
Text needs to have sufficient color contrast from its background in order to be legible to users 

with low vision. Users with color blindness, or using monochrome technologies, may not be 

able to see information conveyed solely with color. Pages with color should be designed so 

that all information conveyed with color is also available without color.  

PDF/UA does not specify a value for what constitutes sufficient color contrast. We will 

reference an equivalent drawn from the web standard, the Web Content Accessibility 

Guidelines (WCAG) 2.0. For text, aim for a contrast ratio of at least 4.5:1. An example is: 

· Black text (with an RGB color value of “0 0 0”),  

· on a white background (with an RGB color value of “255 255 255”),  

· has a contrast ratio of 21.0:1, far above 4.5:1. 

Images 
Photos, technical diagrams, and graphics (e.g. pie charts) are examples of images. They are 

considered "non-text" content; as such, they require some form of descriptive text. This 

alternative text (“alt text”) is accessible to screen readers and allows the content and function 

of the image to be accessible to users with visual or cognitive impairments. Alternative text 

should be brief, meaningful and as informative as possible.  

In Figure 4 below, the process of adding alt text is illustrated. First, open the shortcut menu 

by right-clicking on an image, and choose "Format Picture". Next choose "Alt Text" from the 

options, and enter a brief explanation in the Description field. 

In MS Word, images should be placed “in line” with text, meaning the text does not wrap 

around it because it is essentially part of the paragraph. Images that are not in line with text 

may not be detected by screen readers. 

Note that images containing text (“graphical text”) should have sufficient foreground-to-

background color contrast, as discussed in the previous section. This helps users who have low 

http://www.example.com/
http://www.example.com/
http://www.example.com/
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vision perceive and understand the image. There are exceptions to this guideline: logos and 

brand marks may have specific colors that should not be changed.  

Adjusting the contrast within a photo can be difficult, and doing so generally requires 

dedicated graphics software and attention. 

Figure 4: Right-click on an image and choose "Alt Text" from the options to add 

alternative text. 

Converting an MS Word Document to PDF 

If you simply save/print a Word document as a PDF, many steps we have looked at in MS 

Word may not automatically carry over to the PDF document. Your organization will require a 

conversion plug-in, such as CommonLook Office or Adobe PDFMaker®, or a stand-alone 

application, such as Adobe FrameMaker®, Adobe InDesign®, or OpenOffice Writer. This 

software can use the improvements to accessibility you have made to create a properly 

tagged, accessible PDF. 
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Modifying a PDF in Adobe Acrobat 

Once you have created a PDF, or if you have received one, you can open it to see how 

accessibility features have been implemented. Adobe Acrobat has the ability to open PDFs 

created in other applications and immediately identify whether a document has been tagged 

accessibly. Furthermore, Acrobat will take any document that has not been tagged and offer to 

attempt to add tags to it. It will do this before allowing you to open the document to read it. 

This can be useful, but do not rely on it to create an accessible PDF for you: Acrobat has to 

estimate the meaning and value of what it finds, and it may not do so suitably. 

PDF Tags and the Tags Pane 
Tags are visible in the Acrobat interface. A tagged PDF, as seen in Figure 5, will display tags 

in the Tags pane on the left-hand side of the Acrobat window. Open the pane by clicking the 

Tags pane button or by using the View menu > Show/Hide > Navigation Pane option.  

Figure 5: The PDF displays its accessibility tagging structure in the "Tags" pane. 
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Tags resemble their namesake in HTML: in this example, “Data Tables” is contained in the 

highlighted <H1> and is followed by two paragraphs of text, represented in the Tags pane by 

<P> tags, and then a data table, shown as <Table>. 

Edit a tag by right-clicking it, selecting “Properties” and then changing the “Type”. Tags can be 

expanded to show their respective components or collapsed for ease of review. For example, 

lists can be expanded to see each of their list items.   

Text Structure 
Ordinary text is probably the most common element in PDFs, especially for brochures, press 

releases, annual reports and similar documents. In a customer PDF, text may be contained 

within a wide variety of tags, including "Paragraph" and "Span".  

The entire document may be structured through the use of tags, in a fashion similar to the 

following: 

· Document 

o Story or Article 

§ Paragraph (and other content) 

To simplify this guide and focus on accessibility, we will examine only Paragraph tags, in the 

event that text has not been captured in the tagging structure. Paragraph tags may contain 

other tags, including one or more Span (<SPAN>) tags.  

As much as possible, work with the tags that come with a customer PDF: it isn't necessary to 

redefine existing tags, which already provide structure to content. It is also usually not 

necessary to remove tags, such as the Document, Story, and Article tags.  

All content is organized under headings: there will be major headings for main content areas, 

which are in turn sub-divided under sub-headings. All headings are numbered to provide 

different levels: they start at Heading 1 (<H1>) for the document title or most significant 

sections; subordinate sections are split into Heading 2s (<H2>), Heading 3s (<H3>), and so 

on. Headings are both an important structural component and a navigation landmark. They 

are all screen reader-accessible, helping users understand the document structure and quickly 

navigate the contents to find what they need.  

Each level of heading can be used multiple times throughout a given document. For example, 

there is no rule that H1 can be used only once, but the different levels should "nest" inside 

each other properly, and levels should not be skipped. Therefore, H1 will precede H2, which 
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can have multiple H3 and then H4 sub-sections inside it, but the document should never jump 

from H1 to H3, or H2 to H4. 

Adding or Modifying Tags 
There are two major ways to add or modify tags in a PDF: 

· Open the Tags pane and access tags already in the document.  

· Open the Tools pane on the right-hand side, expand the Accessibility tab, and use 

the Touch-Up Reading Order Tool.  

The Tags pane allows you to manipulate existing tags in a variety of ways, whereas the Touch-

Up Reading Order Tool allows you to visually outline areas and define them with tags. The 

latter is useful when a document is inaccurately tagged or completely untagged.   

Despite its name, the Touch-Up Reading Order Tool allows you to work with a "broad swath" 

of a page, while the Tags pane provides fine control over individual tags. 

Tags Pane 
The Tags pane allows you to do to the following:  

· move tags within the document order;  

· modify individual tag properties;  

· change an existing tag's type; and  

· add, delete, cut and paste individual tags within the order.   

One of its most useful features is to simply drag-and-drop individual tags to move them 

around in the document order. If the tags do not follow the visual order, simply select and 

drag them to the appropriate location. 

Right-click to open the shortcut menu and see a variety of options to add, edit, or cut and 

paste tags as shown in Figure 6 below. 
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Figure 6: From the Tags pane, you can open the shortcut menu to edit tags. 

There are options to add a New Tag as well as Delete existing tags. It is helpful to keep the 

Highlight Content option checked, as this highlights the content element in the center pane 

when its associated tag is selected. 

If you need to change the properties of an individual tag, open the Properties dialog box 

through the shortcut menu. This is useful if an element is tagged incorrectly. Simply select a 

tag, open the shortcut menu, and click the Properties option. From here, click the Tag tab; you 

can use the Type drop-down menu to select the appropriate tag, as shown in Figure 7 below. 

On this tab, the kind of tag is determined by the Type dropdown menu. You can select a more 

correct Type for a given tag here.  

You can type directly into the Type dropdown menu field; however, ensure that your entry is 

capitalized. 

If you are handling an image, the Tag tab is also where the Alternate Text field is located. 

Ensure that all images have appropriate alternative text. 
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Figure 7: From the shortcut menu, open the Properties dialog box to choose a 

different tag Type. 
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TouchUp Reading Order Tool 
If the document is untagged, or if the existing tag structure is obviously incorrect, it may be 

necessary to use the "broad swath" approach of the TouchUp Reading Order Tool. Open the 

right-hand Tools pane, expand the Accessibility tab and click the TouchUp Reading Order 

Tool button. Figure 8 demonstrates this process. Once the Tool is open, any areas containing 

tags are highlighted with a grey, numbered box. These boxes contain one or multiple tags. 

Any untagged content will not be displayed in a box. To use the Tool, simply click-and-drag 

over an area to create the grey highlighting box and select an appropriate button to create a 

tag. 

Sometimes the boxes do not accurately represent the tag structure visually. Also note that, in 

Figure 8, the lower box does not cover the complete table. In fact, the table is correctly and 

completely tagged, but only by visually examining the Tags pane or running an accessibility 

checker can we confirm this. 

When marking a data table, take care to capture not only the table exterior, but also each of 

the regular cells and the header cells. This will be discussed in more detail below. 

Figure 8: From the Tools panel, open the TouchUp Reading Order Tool. 
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Data Tables 
Data tables need to be organized by type of cell so that screen readers can navigate them. 

· Data cells contain the actual data, which as described earlier in this guide, is the 

purpose of the table. 

· Header cells (or "headers") are usually the first cells at the top of columns or the 

start of rows and define and categorize the data in regular cells. Some tables may 

have more than one row or column of header cells. Screen readers will read every 

header that applies to a given cell before reading the cell data itself. 

Table formatting usually informs us what the headers are and where they are located. Acrobat 

organizes cells into Table Rows (TR). Ensure that each row contains the correct headers and 

data cells by comparing the tags pane to the visual reading order. 

1. Ensure that all header cells are identified with the Table Header (TH) tag. 

2. All remaining non-header cells should be marked with the Table Data (TD) cell tag. 
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Figure 9: A data table split into rows (TR) containing header cells (TH) and data cells 

(TD). 

Lists 
As with MS Word, lists in PDFs include both the ordered ("numbered") and unordered ("bullet 

point") types. If lists were created correctly in the initial document, the list should already be 

properly structured upon conversion to PDF. If not, they will need remediation in the Tags 

pane in accordance with the following structure. 

· All lists reside in an L tag in the Tags pane. 

o The L tag is a parent to one or more LI (list item) tags nesting inside. 

§ Each LI tag itself contains two child tags: 

· A label tag (Lbl), containing the list bullet or number. 

· A body tag (LBody) containing the text content of the item. 
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Lists can be tricky to work with. Often they require changing the tag type in the Properties 

window or manually dragging and dropping to get the order correct.  

Figures (Graphics) 
The term used in Adobe Acrobat for all graphic elements is Figures. Figures are considered 

either “meaningful” or "decorative".  

· Meaningful graphics provide information, and this information can be expressed as 

text (“alternative text” or “alt text”), which screen readers can read. Generally, maps, 

charts, graphs, photos and logos are examples of meaningful graphics.  

· Decorative graphics are simply aesthetic elements, which lack meaningful textual 

interpretation. They do not have alternative text and will be ignored by screen 

readers. 

This distinction is often subjective. Make the best determination possible as to which category 

a graphic falls into and assign alternative text based on the surrounding content, the text in 

the graphic or relevant captions. Shorter alt text is best because older screen readers may 

skip over long alt text, and there is less of a break from the surrounding content. 

Use the Touch-Up Reading Order Tool to  

1. Click-and-drag to outline each graphic.  

2. Click the button for Figure.  

3. Open the Properties panel in the shortcut menu and assign the Alternative Text. 
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Figure 10: Outline the graphic element then click the Figure button. 

Complex graphics (pie charts, flow charts, technical diagrams) may be split into multiple 

figures. 

Any "decorative-only" graphics can be outlined with the Touch-Up Reading Order Tool and 

declared as Background: this renders it as an Artifact, which will be ignored by screen readers 

(more about Artifacts below). 

Artifacts 
It is sometimes easy to determine which graphics are decorative and to mark them as 

Artifacts. However, PDF accessibility checkers, such as PAC2, will often find other surprising 

elements of a document and notify you that elements have not been tagged as Artifacts. 

These may include graphic elements in table design as well as solid-colored bars used in page 

headers and footers. Often these are graphics that have been added as part of the Adobe 

InDesign process.  

Therefore, tag a document as thoroughly as possible, identifying decorative graphics, and then 

run an accessibility checker to find less obvious elements. You can then mark these as 

Artifacts using the Background button on the Touch-Up Reading Order Tool.  
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As with Figures, use the Touch-Up Reading Order Tool to  

1. Click-and-drag to outline each graphic.  

2. Click the button for Background (see Figure 11 below). 

Doing so will remove any tag associated with the graphic in the Tags pane and will ensure that 

the Content view (more on this below) considers the graphic as an Artifact. 

Figure 11: If the graphic is decorative-only, click the Background button in the 

TouchUp Reading Order Tool. 

After Tagging: Content Order and Tab Order 
What can be confusing about PDFs is the relationship between the tag order, the content 

order, and the tab order. Unlike HTML, tags in PDFs only apply to screen readers. By contrast, 

content order refers to the sequence in which content objects will fall if the document is 

"reflowed". A “reflowed” document is one with a linearized, one-column view that is beneficial 

for users who have low vision. Tab order refers to the sequence in which interactive elements, 

including hyperlinks and form elements, receive browser focus if the user is performing 

keyboard (or "tab") navigation. Users with vision or mobility disabilities may not be able to use 
 

SIMPLIFYING ACCESSIBLE COMMUNICATIONS.TM 

 info@tbase.com | www.tbase.com | Toll-free: 1-800-563-0668 

21 



                                                     
 
 
                                                                                                               OTTAWA, ON | OGDENSBURG, NY 
                                                    

a mouse to navigation through documents and applications. They will instead rely on keyboard 

commands, particularly the Tab key to jump to interactive elements such as hyperlinks, form 

fields and controls. But Tabbing through the document may be difficult and confusing if the tab 

order is not set to follow the document reading structure.  

So aside from adding tags and ensuring they fall into the correct sequence in the Tags pane, 

ensure that the content order and the tab order are congruent. This way, the screen reader-

accessible tags, the content objects, and the tabbing navigation throughout the document will 

be consistent with each other, ensuring the document has the same sequence regardless of 

who is reading it—people who are blind or have low vision using screen readers or people who 

have low vision using screen magnification.  

After the document has been tagged, review the content order by following these steps: 

1. Open the Content pane. 

2. Expand all the content sections, and step through them using the arrow keys. 

3. Ensure they follow the same logical progression as in the Tags pane.  

4. If anything needs to be changed, the same options as in the Tags pane are available: 

drag-and-drop and the shortcut menu options to cut, paste, and alter properties. 

See Figure 12 below for an illustration. 

Note: For this step, we recommend saving your document often, and, to be extra careful, 

save a new version before following the instructions below, as the measures described herein 

cannot be undone. Be sure of the step you want to take before you take it, and check that any 

content you want to see has not disappeared once you’ve taken a step. If this occurs, you may 

need to close the document without saving and re-open it from the last save point.  

Now, set the tab order so that it uses the document structure as follows: 

1. Open the Page Thumbnails pane. 

2. Click on each page in turn. 

3. After selecting the page by clicking, open the Options menu and click Page 

Properties. 

4. Set the Tab Order to the Use Document Structure radio button. 

See Figure 13 below for an illustration. 
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Figure 12: In the Content pane, object order must be the same as the Tag order. 

Figure 13: Set Tab Order to Use Document Structure. 
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Document Properties 
Beyond tagging the elements and ensuring the correct tag order, there are steps concerning 

the document as a whole that you can take to improve accessibility. Among these steps is 

adding "metadata" to the document, which will help the user search for and identify the 

document. 

Every PDF should have a title. You might find the title in the file name or the first heading of 

the document. After determining the correct title based on the topic of your document and its 

content, make it official so it appears in the title bar and will be read by screen readers. 

1. Open File > Properties.  

2. In the Description tab, fill out the Title field. 

3. In the Initial View tab, look at the Window Options box and set the Show field to 

"Document Title". 

Also set the default language so that screen readers will load the correct pronunciation set. 

1. Open File > Properties.  

2. In the Advanced tab, look at the Reading Options box and set the Language field 

to the appropriate language. 

Finally, the PAC2 checker will always register an error unless a PDF/UA identifier is attached to 

the document, regardless of how well accessibility has been otherwise addressed. Often this 

identifier is not attached because customers rarely know about it. The identifier can simply be 

a generic "xmp" file; we have them available for this purpose. How to add the identifier: 

1. Open File > Properties.  

2. In the Description tab, click the Additional Metadata button, and then select the 

Advanced page on the following screen. 

3. Click the Append All button, and upload the "xmp" PDF/UA identifier file. 

Acrobat Accessibility Check / PAC 2 Checker  

At this point, we have taken every proactive step to render the document accessible without 

actually testing it in the middle of the process. We recommend testing during the accessibility 

process, but for this section we will assume that no checking has happened before the very 
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end. Even after you have successfully completed all the preceding steps, both checkers may 

return error messages and state the PDF is not fully accessible. Often this is because there are 

hidden elements within the document that were not captured by the accessibility conversion 

process. We have found this to be the case particularly when the document was created in 

Adobe InDesign—as mentioned in the section on Artifacts. 

We will consider two accessibility checking tools:  

· the Accessibility Check built into Acrobat; and  

· the PDF Accessibility Checker (PAC 2). 

The Accessibility Check in Acrobat (earlier versions have both "Quick" and "Full" check 

options: always choose the "Full" check) is handy because it checks on the criteria discussed 

previously. It functions quickly, and the resulting reports are easy to interpret and address; 

however, on its own, it is insufficient for checking PDF/UA compliance. 

PAC 2 is freely available as a download from the PDF Association and can be downloaded at 

http://www.access-for-all.ch/en/pdf-lab/pdf-accessibility-checker-pac.html. It is a very 
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powerful tool, checking against 31 Checkpoints and 136 Failure Conditions drawn from 

PDF/UA. It mandates a very high standard of accessibility and can check elements that the 

Acrobat Check cannot. By contrast, some of the errors it returns are neither easy to 

understand nor to uncover and remediate. 

Acrobat Accessibility Check 
Access the Acrobat Accessibility Check and run a report by performing the following steps. 

1. Open the Tools pane on the right-hand side (see Figure 14 below).  

2. Expand the Accessibility tab. 

3. Select the option for Full Check. 

4. Check that the options are correct for your document and click Start Checking. 

http://www.access-for-all.ch/en/pdf-lab/pdf-accessibility-checker-pac.html
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Figure 14: Configure the Accessibility Check and launch the report. 

The report will appear to the left of the PDF itself; this is a condensed version, and the actual 

report is a separate saved file. It organizes the results by page and provides hyperlinks to the 

specific error. Clicking the hyperlink will highlight the relevant content block (see Figure 15 

overleaf). 

You can run the Check as many times as necessary. Often it is best to run it multiple times 

while creating the PDF and to track as the report gradually clears. Figure 15 shows several 

examples of typical Accessibility Check report errors, including the following: 

· images without alternate text 

· list items (LI tags) without parent lists (L tags) 

· list item body tags (LBODY) and labels (Lbl) without parent list items (LI) 

Each of these will have to be corrected in the Tags pane.  
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Figure 15: Clicking a link in the accessibility report will find and highlight the 

element with an error. 

PDF Accessibility Checker (PAC 2) 
Once you have downloaded and have access to PAC 2, run a report by performing the 

following steps. 

1. Open the folder it resides in and run the executable.  

2. Select the file in the Browse box and click the Start button. 

3. PAC 2 will examine the file; it displays green checkmarks, red x's, and yellow signs for 

pass, fail, and warnings. Figure 16 overleaf shows the check in progress. 

4. Once the check is complete, click the Report button to see the expandable detail 

view. Figure 17 below shows how the report displays errors. 
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Figure 16: The PAC 2 interface: simply select the file to check and click Start. 

Tracking down the remaining issues usually involves opening the left-hand Content pane (not 

the accessibility Tags pane) and finding any elements that have fallen outside of content 

order.  

The checker may return an error message stating that an image was not marked for 

accessibility, which can be surprising, as you may have already marked images as Artifacts. 

When an Artifact is created by way of using the Touch-Up Reading Order Tool to draw a box 

around an element and clicking Background, that object disappears from the Tags pane—it 

moves into the background, specifically in an Artifact located in the Content pane. But even 

then the ordering may be askew, as happens with marking up form fields with accessibility 

tags.  
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1. Open the Content pane, and cross-reference the error found in the checker 

with the same location in the Content pane. 

2. You may find that pieces of the graphic have fallen outside of the Artifact. By 

drag-and-drop or cut-and-paste, place these pieces inside the Artifact. Do this 

and re-check as needed, until the error in the checker disappears. 

Alternately, the checker may display a message saying that text content was not marked for 

accessibility. This usually refers to blank non-breaking spaces, which were accidentally entered 

into table cells or other structures.  

1. Again, open the Content pane, and cross-reference the error found in the 

checker with the same location in the Content pane. 

2. Usually you will find an expandable reference that resembles this: "Text:", and 

which has no content. Simply delete these, as they have no value. Do this and 

re-check as needed until the error in the checker disappears. 

By alternately running a checker to generate a report, then correcting an error and running 

the checker again, there will be fewer errors returned and eventually the report will be clean. 

At this point, the document can be considered compliant with the requirements of PDF/UA. 
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Figure 17: The PAC 2 report groups similar items together in expanding lists. 

Summary 

The intent of this guide is to form a basis of understanding in creating accessible PDFs. People 

who are responsible for creating these documents within their organization must apply these 

general techniques and tools in the specific situations of their workplace. It is impossible to 

predict exactly what kind of documents you may encounter. Nevertheless, this guide covers 

the concepts and methods necessary to address a large number of potential issues. 

As with most products, accessibility in PDFs is easiest to achieve if it is planned and 

implemented at the beginning. Learn the accessibility features of the source application and 

apply them to the document text, images, and properties. Provide the text content with 

structure, especially with elements which ATs can detect and use. A good way to look at this 

process is using the correct document element (for example, using tables for presentation of 
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data) to represent each content part. When the document converts to PDF, it will more likely 

be accurately tagged automatically.  

After the PDF is created pay careful attention to the tagging structure, it is important to 

ensure that you also consider the document properties, content object order and tag order. A 

tagged document does not automatically equal a completed document. Ensure the tags 

themselves are logical and properly ordered. Test the document frequently using the checking 

tools, and be aware that they are sensitive to different things. 

Even with this approach, there is room for interpretation and imagination when it comes to 

accessible PDFs. If the document has relatively little text but is laid out like an org chart, for 

example, you may need to be a bit creative so the document makes sense to a screen reader 

user. This is part of the reason testing with a screen reader is so important. 

Lastly, the goal is not abstract compliance, but rather enhancing accessibility where it matters 

most: for people, customers, and the public. There is a lot to learn about accessible PDFs as 

the technologies constantly change and evolve. But the goal is to make alternate format 

documents better and to make them more usable for everyone. Any step toward that goal is 

worthwhile. 
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